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Task Brief

	WP Number and Title
	 WP 1
	Analysis of the State of the Art and Development of Concepts

	Task Number and Title
	T 1.4
	Development of the System Specifications

	Sub-Task Number and Title
	
	

	Task Leader and Contact
	VALT
	jean-pierre.lorre@toulouse.valtech.fr

	Deliverable Number and Title
	D 2
	Report: “The REGNET – System: specification and State of the Art”

	Interm. Report Number and Title
	IR 1.4
	Definition of supported Business Functions (2001-06-30)

	Start Date:
	 2001.05.02
	End Date:
	2001.09.30

	Objectives: 
This task belongs to Work Area B:

System specifications will elaborated using state of the art and well proofed methods. 
There will be five main – server side - components (REGNET-Portal, REGNET-Cultural Heritage Data Management, REGNET-eBusiness Data Management, REGNET-Ontology Checker, REGNET-Electronic Publisher) located on different nodes. This will imply a n–tier architecture with interoperable components like protocol gateways, (multi media) data management, data exchange facilities, etc. An outline of the methodologies used is given in the annex. Standard notations (e.g. UML) will be used as applicable.


	Description of Work: 
Definition of the Functional Requirements; development of the REGNET- Architectural Design; identification of Software Components; detailed System Design; definition of  hardware, system, and network requirements; identification of tools.
The work carried out within this task is close to standard software development. 
It is very important to collect user requirements  which reflect as much as possible the real needs so the functional requirements are based on solid ground. The transformation into use cases might be in the very beginning difficult. On the technical basis it should be considered that the REGNET technical infrastructure should be portable to different locations and by no means propriarity or dependent on a few vendors. But the system should be scalable so a high qualified processing centre (e.g. multi media production) could evolve out of the REGNET generic structure.
Process description:

The process uses UML notation and is based on an iterative approach.

The task T1.4 is divided in subtasks.

Each partner should use this process according to the subtask partition. 

Step 1 Use Cases and Actors identification

According to REGNET document and to user requirements list coming from tasks T1.1, the exhaustive list of REGNET Actors and Use Cases is establish.

Step 2 Expanding Vision document

Vision document gives an overview of functional aspect of the software as well as marketing elements and technical architecture.

Objective of this document is to have a global view of the software based mostly on user and technical requirement on use case basis. Of course, the vision document doesn't give a complete technical architecture but only main aspects of this architecture.

Step 3 Iterations definition

Iterations are definied on the basis of Use Case List. Each iteration is based on a sub-set of the use case set. 

Step 4: Specifications

For each iteration repeat :


- Detail Uses cases : that is describe with text interaction between actors and Regnet System.


- Analysis : deduce business objects from use case.

endRepeat


	Description of expected results: 

· The vision document  
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· The use case specification
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· The software requirements specifications
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· The glossary
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	Methodology:  

U.P. (Unified Process methodology)

Language : UML



	Partner
	PM
	Contact (email)
	Obligation

	1. AIT
	1

1

1

1
	kochw@ait.co.at 


	Task T1.4 general

Subtask T1.4.1

Subtask T1.4.2

Subtask T1.4.4

	2. IMAC
	1

1
	grossmann@imac.de 


	Subtask T1.4.1

Subtask T1.4.3

	3. MOT
	1

6

3
	roberto.cicci@motorola.com 


	Task T1.4 general 

Subtask T1.4.1

Subtask T1.4.3

	4. SPAC
	1

1
	silvia.bendinelli@spacesrl.it 


	Subtask T1.4.1

Subtask T1.4.2

	5. VALT
	1

2

2

5
	jean-pierre.lorre@toulouse.valtech.fr

	Task T1.4 general 

Subtask T1.4.1

Subtask T1.4.3

Subtask T1.4.6

	6. ZEUS
	1

1

5

5
	bb@zeusnet.gr 


	Task T1.4 general 

Subtask T1.4.1

Subtask T1.4.3

Subtask T1.4.6

	7. CERT
	1

2

3
	Dimitrios.Tzovaras@iti.gr 
	Task T1.4 general 

Subtask T1.4.2

Subtask T1.4.4

	8. ONB
	1
	
	Subtask T1.4.2

	9. TARX
	1

3
	
	Task T1.4 general 

Subtask T1.4.2

	10. SI
	1

4

3
	nikos.karatzoulis@systema.gr 


	Task T1.4 general 

Subtask T1.4.4

Subtask T1.4.5

	11. SR
	1

5
	
	Task T1.4 general 

Subtask T1.4.5

	Total Effort
	57
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<Project Name>



Use Case Specification: 

<Use-Case Name>



 



Version <1.0>



 



[Note: The following template is provided for use with the 

Rational Unified Process. Text enclosed in square brackets and displayed in blue 

italics (style=InfoBlue) is included to provide guidance to the author and 

should be deleted before publishing the document. A paragraph entered following 

this style will automatically be set to normal (style=Body Text).]



[To customize automatic fields (which display a gray 

background when selected), select File>Properties and replace the Title, 

Subject and Company fields with the appropriate information for this 

document.    After closing the dialog, automatic fields may be 

updated throughout the document by selecting Edit>Select All (or Ctrl-A) and 

pressing F9, or simply click on the field and press F9.  This must be done 

separately for Headers and Footers.  Alt-F9 will toggle between displaying 

the field names and the field contents.  See Word help for more information 

on working with fields.] 
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Use-Case 

Specification: <Use-Case Name>



[bookmark: 1.                  Use Case Name]1.                  

Use-Case Name



[The following template is provided for a Use-Case 

Specification, which contains the textual properties of the use case.  This 

document is used with a requirements management tool, such as Rational 

RequisitePro, for specifying and marking the requirements within the use-case 

properties.



The use-case diagrams can be developed in a visual modeling 

tool, such as Rational Rose.  A use-case report (with all properties) 

may be generated with Rational SoDA.  For more information, see the tool 

mentors in the Rational Unified Process.]



[bookmark: 1.1               Brief Description]1.1               

Brief Description



[The description briefly conveys the purpose of the use 

case.  A single paragraph will suffice for this description.]



[bookmark: 2.                  Flow of Events]2.                  

Flow of Events



[bookmark: 2.1               Basic Flow]2.1               

Basic Flow 



[This use case starts when the actor does something.  An 

actor always initiates use cases.  The use case describes what the actor 

does and what the system does in response.  It needs to be phrased in the 

form of a dialog between the actor and the system.



The use case describes what happens inside the system, but not 

how or why.  If information is exchanged, be specific about what is passed 

back and forth.  For example, it is not very illuminating to say that the 

actor enters customer information. It is better to say the actor enters the 

customer’s name and address.  A Glossary of Terms is often useful to keep 

the complexity of the use case manageable—you may want to define things like 

customer information there to keep the use case from drowning in details. 



Simple alternatives may be presented within the text of the 

use case.  If it only takes a few sentences to describe what happens when 

there is an alternative, do it directly within the Flow of Events 

section.  If the alternative flow is more complex, use a separate section 

to describe it.  For example, an Alternative Flow subsection 

explains how to describe more complex alternatives. 



A picture is sometimes worth a thousand words, though there is 

no substitute for clean, clear prose.  If it improves clarity, feel free to 

paste graphical depictions of user interfaces, process flows or other figures 

into the use case.  If a flow chart is useful to present a complex decision 

process, by all means use it!  Similarly for state-dependent behavior, a 

state-transition diagram often clarifies the behavior of a system better than 

pages upon pages of text.  Use the right presentation medium for your 

problem, but be wary of using terminology, notations or figures that your 

audience may not understand.  Remember that your purpose is to clarify, not 

obscure.]



[bookmark: 2.2               Alternative Flows]2.2               

Alternative Flows



[bookmark: 2.2.1          < First Alternative Flow >]2.2.1          

< First Alternative Flow >



[More complex alternatives are described in a separate 

section, referred to in the Basic Flow subsection of Flow of 

Events section.  Think of the Alternative Flow subsections like 

alternative behavior—each alternative flow represents alternative behavior 

usually due to exceptions that occur in the main flow.  They may be as long 

as necessary to describe the events associated with the alternative 

behavior.  When an alternative flow ends, the events of the main flow of 

events are resumed unless otherwise stated.]



2.2.1.1     

< An Alternative Sub-flow >



[Alternative flows may, in turn, be divided into subsections 

if it improves clarity.]



[bookmark: 2.2.2          < Second Alternative Flow >]2.2.2          

< Second Alternative Flow >



[There may be, and most likely will be, a number of 

alternative flows in a use case.  Keep each alternative flow separate to 

improve clarity.  Using alternative flows improves the readability of the 

use case, as well as preventing use cases from being decomposed into hierarchies 

of use cases.  Keep in mind that use cases are just textual descriptions, 

and their main purpose is to document the behavior of a system in a clear, 

concise, and understandable way.]



[bookmark: 3.                  Special Requirements]3.                  

Special Requirements



[A special requirement is typically a nonfunctional 

requirement that is specific to a use case, but is not easily or naturally 

specified in the text of the use case’s event flow. Examples of special 

requirements include legal and regulatory requirements, application standards, 

and quality attributes of the system to be built including usability, 

reliability, performance or supportability requirements. Additionally, other 

requirements—such as operating systems and environments, compatibility 

requirements, and design constraints—should be captured in this section.]



[bookmark: 3.1               < First Special Requirement >]3.1               

< First Special Requirement >



 



[bookmark: 4.                  Pre-Conditions]4.                  

Pre-conditions



[A pre-condition of a use case is the state of the system that 

must be present prior to a use case being performed.]



[bookmark: 4.1               < Pre-condition One >]4.1               

< Pre-condition One >



 



[bookmark: 5.                  Post-Conditions]5.                  

Post-conditions



[A post-condition of a use case is a list of possible states 

the system can be in immediately after a use case has finished.]



[bookmark: 5.1               < Post-condition One >]5.1               

< Post-condition One >



 



[bookmark: 6.                  Extension Points]6.                  

Extension Points



[Extension points of the use case.]



[bookmark: 6.1               <Name of Extension Point>]6.1               

<Name of Extension Point>



[Definition of the location of the extension point in the flow 

of events.]
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Version <1.0>





 





 





[Note: The

following template is provided for use with the Rational Unified Process. 

Text enclosed in square brackets and displayed in blue italics (style=InfoBlue)

is included to provide guidance to the author and should be deleted before

publishing the document. A paragraph entered following this style will

automatically be set to normal (style=Body Text).]
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Software

Requirements Specification 





[bookmark: 1.__________________Introduction]1.                 

Introduction





[The

introduction of the Software Requirements Specification (SRS) should

provide an overview of the entire document. It should include the purpose,

scope, definitions, acronyms, abbreviations, references, and overview of the Software

Requirements Specification.]





[Note: The Software

Requirements Specification captures the complete software requirements for

the system, or a portion of the system.  Following is a typical Software

Requirements Specification outline for a project using use-case modeling.

This artifact consists of a package containing use cases of the use-case model

and applicable Supplementary Specifications and other supporting information.]





 





[bookmark: 1.1_______________Purpose]1.1              

Purpose





[Specify the

purpose of this Software Requirements Specification. The Software

Requirements Specification should fully describe the external behavior of

the application or subsystem identified. It also describes nonfunctional

requirements, design constraints and other factors necessary to provide a

complete and comprehensive description of the requirements for the software.]





[bookmark: 1.2_______________Scope]1.2              

Scope





[A brief

description of the software application that the Software Requirements

Specification applies to; the feature or other subsystem grouping; what

Use-case model(s) it is associated with; and anything else that is affected or

influenced by this document.]





[bookmark: 1.3_______________Definitions,_Acronyms_]1.3              

Definitions, Acronyms and

Abbreviations





[This

subsection should provide the definitions of all terms, acronyms, and

abbreviations required to properly interpret the Software Requirements

Specification.  This information may be provided by reference to the

project Glossary.]





[bookmark: 1.4_______________References]1.4              

References





[This

subsection should provide a complete list of all documents referenced elsewhere

in the Software Requirements Specification.  Each document should

be identified by title, report number (if applicable), date, and publishing

organization.  Specify the sources from which the references can be

obtained. This information may be provided by reference to an appendix or to

another document.]





[bookmark: 1.5_______________Overview]1.5              

Overview





[This

subsection should describe what the rest of the Software Requirements

Specification contains and explain how the document is organized.]





[bookmark: 2.__________________Overall_Description]2.                 

Overall Description





[This

section of the Software Requirements Specification should describe the

general factors that affect the product and its requirements.  This

section does not state specific requirements.  Instead, it provides a

background for those requirements, which are defined in detail in Section 3,

and makes them easier to understand. Include such items as product perspective,

product functions, user characteristics, constraints, assumptions and

dependencies, and requirements subsets.]





[bookmark: 2.1_______________Use-Case_Model_Survey]2.1              

Use-Case Model Survey





 [Tthis

section contains an overview of the use-case model or the subset of the

use-case model that is applicable for this subsystem or feature.  This

includes a list of names and brief descriptions of all use cases and actors,

along with applicable diagrams and relationships.  Refer to the Use-Case-Model

Survey Report, which may be used as an enclosure at this point.]





[bookmark: 2.2_______________Assumptions_and_Depend]2.2              

Assumptions and Dependencies





[This

section describes any key technical feasibility, subsystem or component

availability, or other project related assumptions on which the viability of

the software described by this Software Requirements Specification may

be based.]





[bookmark: 3.__________________Specific_Requirement]3.                 

Specific Requirements 





[This

section of the Software Requirements Specification should contain all

the software requirements to a level of detail sufficient to enable designers

to design a system to satisfy those requirements and testers to test that the

system satisfies those requirements.   When using use-case modeling, these

requirements are captured in the use cases and the applicable supplementary

specifications.  If use-case modeling is not used, the outline for

supplementary specifications may be inserted directly into this section.]





[bookmark: 3.1_______________Use-Case_Reports]3.1              

Use-Case Reports





[The use

cases often define the majority of the functional requirements of the system,

along with some non-functional requirements.  For each use case in the

above use-case model, or subset thereof, refer to, or enclose, the use-case

report in this section.  Make sure that each requirement is clearly

labeled.]





[bookmark: 3.2_______________Supplementary_Requirem]3.2              

Supplementary Requirements 





[Supplementary

Specifications capture requirements that are not included in the use

cases.  The specific requirements from the Supplementary Specifications,

which are applicable to this subsystem or feature, should be included here and

refined to the necessary level of detail to describe this subsystem or

feature.  These may be captured directly in this document or referred to

as separate Supplementary Specifications, which may be used as an enclosure at

this point. Make sure that each requirement is clearly labeled.]





[bookmark: 4.__________________Supporting_Informati]4.                 

Supporting Information





[The

supporting information makes the Software Requirements Specification

easier to use.  It includes:





•          

Table of Contents





•        

Index





•        

Appendices 





 These

may include use-case storyboards or user-interface prototypes. When appendices

are included, the Software Requirements Specification should explicitly

state whether or not the appendices are to be considered part of the

requirements.]
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<Project Name>



Glossary



 



Version <1.0>



 



 



[Note: The following template is provided for use with the 

Rational Unified Process. Text enclosed in square brackets and displayed in blue 

italics (style=InfoBlue) is included to provide guidance to the author and 

should be deleted before publishing the document. A paragraph entered following 

this style will automatically be set to normal (style=Body Text).]



[To customize automatic fields (which display a gray 

background when selected), select File>Properties and replace the Title, 

Subject and Company fields with the appropriate information for this 

document.    After closing the dialog, automatic fields may be 

updated throughout the document by selecting Edit>Select All (or Ctrl-A) and 

pressing F9, or simply click on the field and press F9.  This must be done 

separately for Headers and Footers.  Alt-F9 will toggle between displaying 

the field names and the field contents.  See Word help for more information 

on working with fields.] 
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Glossary



[bookmark: 1.                  Introduction]1.                  

Introduction



[The introduction of the Glossary provides an overview 

of the entire document.  Present any information the reader might need to 

understand the document in this section. This document is used to define 

terminology specific to the problem domain, explaining terms which may be 

unfamiliar to the reader of the use-case descriptions or other project 

documents.  Often, this document can be used as an informal data dictionary, capturing data definitions so 

that use-case descriptions and other project documents can focus on what the 

system must do with the information.  This document should be saved in a 

file called Glossary.]



[bookmark: 1.1               Purpose]1.1               

Purpose



[Specify the purpose of this Glossary.]



[bookmark: 1.2               Scope]1.2               

Scope



[A brief description of the scope of this Glossary; 

what Project(s) it is associated with and anything else that is affected or 

influenced by this document.]



[bookmark: 1.3               References]1.3               

References



[This subsection provides a complete list of all documents 

referenced elsewhere in the Glossary.  Identify each document by 

title, report number if applicable, date, and publishing organization.  

Specify the sources from which the references can be obtained. This information 

may be provided by reference to an appendix or to another document.]



[bookmark: 1.4               Overview]1.4               

Overview



[This subsection describes what the rest of the 

Glossary contains and explains how the document is organized.]



[bookmark: 2.                  Definitions]2.                  

Definitions



[The terms defined here form the essential substance of the 

document.  They can be defined in any order desired, but generally 

alphabetic order provides the greatest accessibility.]



[bookmark: 2.1               <aTerm>]2.1               

<aTerm>



[The definition for <aTerm> is presented here.  As 

much information as the reader needs to understand the concept should be 

presented.]



[bookmark: 2.2               <anotherTerm>]2.2               

<anotherTerm>



The definition for <anotherTerm> is presented 

here.  As much information as the reader needs to understand the concept 

should be presented



[bookmark: 2.3               <aGroupofTerms>]2.3               

<aGroupofTerms>



[Sometimes it's useful to organize terms into groups to 

improve readability.  For example, if the problem domain contains terms 

related to both accounting and building construction (as would be the case if we 

were developing a system to manage construction projects), presenting the terms 

from the two different sub-domains might prove confusing to the reader.  To 

solve this problem, we use groupings of terms.  In presenting the grouping 

of terms, provide a short description that helps the reader understand what 

<aGroupOfTerms> represents.  Terms presented within the group should 

be organized alphabetically for easy access.]



[bookmark: 2.3.1          <aGroupTerm>]2.3.1          

<aGroupTerm>



[The definition for <aGroupTerm> is presented here. 

Present as much information as the reader needs to understand the concept.]



[bookmark: 2.3.2          <anotherGroupTerm>]2.3.2          

<anotherGroupTerm>



[The definition for <anotherGroupTerm> is presented 

here. Present as much information as the reader needs to understand the 

concept.]



[bookmark: 2.4               <aSecondGroupofTerms>]2.4               

<aSecondGroupofTerms>



[bookmark: 2.4.1          <yetAnotherGroupTerm>]2.4.1          

<yetAnotherGroupTerm>



[The definition for the term is presented here. Present as 

much information as the reader needs to understand the concept.]



[bookmark: 2.4.2          <andAnotherGroupTerm>]2.4.2          

<andAnotherGroupTerm>



[The definition for the term is presented here. Present as 

much information as the reader needs to understand the concept.]
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Vision





1.                 

[bookmark: 1.__________________Introduction]Introduction





 





[bookmark: 1.1_______________Purpose]1.1              

Purpose





 





The

purpose of this document is to collect, analyze, and define high-level needs

and features of the REGNET System.  





It focuses on :





Ø      

the

capabilities needed by the REGNET partners, stakeholders,





Ø      

and the

target users, 





Ø       and why these needs exist.  





The

details of how the REGNET System fulfils these needs are detailed in the

use-case.





 





[bookmark: 1.2_______________Scope]1.2              

Scope





 





REGNET is

in keeping with the general pattern of Information Society Technologies Program

of European Community. 





REGNET

aims to set up a functional network of service centers in Europe which provides

IT-services dedicated to Cultural Heritage organizations :





ü    

It

will provide access and use of digital data (scientific and cultural) as well

as of physical goods as provided by museum shops.





ü    

REGNET

will be an enabler of e-Business activities for CH organizations. It will

integrate multi media industries enabling the production of electronic

publications.  





REGNET system consists of 5 building

blocks (nodes) :





Ø    

REGNET

– Portal (access to remote entry data, distributed research, e-business)





Ø    

REGNET

– Cultural Heritage Data Management (search over distributed meta data

repositories connected to stores containing digital content)





Ø    

REGNET

– eBusiness Data Management (e-commerce system allowing access to distributed

product/services catalogues)





Ø    

REGNET

– Ontology (Metadata) Subsystem (containing the specifications of all metadata

needed in the Cultural Heritage domain as well as in the e-business domain;

this subsystem also stores specifications of workflows and process related

metadata)





Ø    

REGNET

– Electronic Publishing Subsystem   (

allowing the production of personalized digital products based on standardized

meta data and workflows)





 





The technical system is based on

sound developments, especially in the field of accessing digital goods (Search

and Retrieval Protocol Z39.50) , it will be taken into account recent

activities in the field of MetaData (Dublin Core) , e-business process

(RosettaNet), and electronic commerce workshop (CEN/ISSS).





It can be accessed with mobile

mobile devices via de facto standard protocol (WAP,…)





 





25 partners, cultural organizations

and IT-industry representatives, from 10 European Union states as well as

Bulgaria and Russia are participating in REGNET.





 





 





 












[bookmark: 1.3_______________Definitions,_Acronyms_]1.3              

Definitions,

Acronyms and Abbreviations





 





B2B : Business to Business





B2C : Business to Consumer





CH : Cultural Heritage





CSC : Cultural Service Center





OPACS

: Online Public

Access Catalogues





REGNET : acronym stands for “Cultural Heritage

in REGional NETworks”.





 





TBC if relevant :               To

Be Completed if relevant





 





1.4              

[bookmark: 1.4_______________References]References





 





REGNET

Contract, IST-2000-26336, IST Programme





                              





1.5              

[bookmark: 1.5_______________Overview]Overview





 





 [This subsection should describe what the

rest of the Vision document contains and explain how the document is

organized.]












2.                 

[bookmark: 2.__________________Positioning]Positioning





 





[bookmark: 2.1_______________Business_Opportunity]2.1                 

Business

Opportunity





 





 





1.      

increase

the competitiveness in the global market place of European CH organizations

(libraries, museums, archives, galleries) by allowing them :


· to manage their data base,


· to have facilities for multi-media production,


· to offer access to their digital contents,

services and products to their clients,


· to cooperate with other partners during creation

of databases, generation of multi media products or creation of a virtual

exhibition.





2.      

boost

the cross-cultural knowledge within European regions, increase the cultural

stimuli of the citizen and contribute of a multicultural and more European

awareness and feeling





 





2.2              

[bookmark: 2.2_______________Problem_Statement]Problem Statement       





TBC if relevant





[Provide a

statement summarizing the problem being solved by this project. The following

format may be used:]







 

  		

  The problem of



  

  		

  [describe

  the problem]



  

 



 

  		

  Affects



  

  		

  [the stakeholders

  affected by the problem]



  

 



 

  		

  the impact of which is



  

  		

  [what is

  the impact of the problem]



  

 



 

  		

  a successful solution would be



  

  		

  [list some

  key benefits of a successful solution]



  

 









 





 












2.3              

[bookmark: 2.3_______________Product_Position_State]REGNET Product Position Statement





 





This array

summarize the intent of REGNET to CH organizations :





 







 

  		

  For



  

  		

  Content

  providers, 


  Cultural Service Center, 


  Media producer, 


  End User



  

 



 

  		

  Who



  

  		

  Need

  access facilities to distributed heterogeneous catalogues of libraries,

  museums, archives and galleries,


  Need to offer services and products to their clients, 


  And need to co-operate in the Cultural Heritage domain (e.g. to produce a

  CDROM)



  

 



 

  		

  The REGNET system



  

  		

   Is

  an software tool



  

 



 

  		

  That



  

  		

  Provides

  facilities of  management and access

  of the digital contents, services and products in the Cultural Heritage

  domain,


  And provides eBusiness processes



  

 



 

  		

  REGNET



  

  		

  Consists

  to 


  - Distributed Search end Retrieval 


  - Market Place


  - Shop Online



  

 









 












3.                 

[bookmark: 3.__________________Stakeholder_and_User]Stakeholder and User Descriptions





[To

effectively provide products and services that meet your stakeholders’ and

users' real needs, it is necessary to identify and involve all of the

stakeholders as part of the Requirements Modeling process.  You must also

identify the users of the system and ensure that the stakeholder community

adequately represents them.  This section provides a profile of the

stakeholders and users involved in the project and the key problems that they

perceive to be addressed by the proposed solution.  It does not describe

their specific requests or requirements as these are captured in a separate

stakeholder requests artifact.  Instead it provides the background and

justification for why the requirements are needed.]





3.1              

[bookmark: 3.1_______________Market_Demographics]Market Demographics





[Summarize

the key market demographics that motivate your product decisions. Describe and

position target market segments. Estimate the market’s size and growth by using

the number of potential users, or the amount of money your customers spend

trying to meet needs that your product or enhancement would fulfill. Review

major industry trends and technologies. Answer these strategic questions:





•

         What is your organization’s

reputation in these markets? 





•         

What would you like it to be? 





•

         How does this product or

service support your goals?]





3.2              

[bookmark: 3.2_______________Stakeholder_Summary]Stakeholder Summary





[Present a

summary list of all the identified stakeholders.]







 

  		

  Name



  

  		

  Represents



  

  		

  Role



  

 



 

  		

  Name the stakeholder type.



  

  		

  Briefly

  describe what they represent with respect to the development.



  

  		

  [Briefly

  describe the role they are playing in the development.



  For

  example, Ensure this….]



  

 









3.3              

[bookmark: 3.3_______________User_Summary]User Summary





[Present a

summary list of all the identified users.]







 

  		

  Name



  

  		

  Description



  

  		

  Stakeholder



  

 



 

  		

  Name the user type



  

  		

  [Briefly

  describe what they represent with respect to the system.]



  

  		

  [List how

  the user is represented by the stakeholders.



  For

  example, Represented by Stakeholder 1.1



  

 









 





3.4              

[bookmark: 3.4_______________User_Environment]User Environment





[Detail the

working environment of the target user. Here are some suggestions:





Number of

people involved in completing the task? Is this changing?





How long is

a task cycle? Amount of time spent in each activity? Is this changing?





Any unique

environmental constraints: mobile, outdoors, in-flight, etc.?





Which

systems platforms are in use today? Future platforms?





What other

applications are in use? Does your application need to integrate with them?





This is

where extracts from the Business Model could be included to outline the task

and business workers involved, and so on.]





3.5              

[bookmark: 3.5_______________Stakeholder_Profiles]Stakeholder Profiles  





[Describe

each stakeholder in the system here by filling in the following table for each

stakeholder.  Remember stakeholder types can be as divergent as users,

strategy departments and technical developers.  A thorough profile should

cover the following topics for each type of stakeholder:]





3.5.1          [bookmark: 3.5.1__________<Stakeholder_Name>]<Stakeholder Name>







 

  		

  Representative



  

  		

  [Who is

  the stakeholder representative to the project?  (optional if documented

  elsewhere.)  What we want here is names.]



  

 



 

  		

  Description



  

  		

  [Brief

  description of the stakeholder type.]



  

 



 

  		

  Type



  

  		

  [Qualify

  the stakeholder’s expertise, technical background, and degree of

  sophistication—that is, guru, business, expert, casual user, etc.]



  

 



 

  		

  Responsibilities



  

  		

  [List the

  stakeholder’s key responsibilities with regards to the system being

  developed—that is, their interest as a stakeholder.]



  

 



 

  		

  Success

  Criteria



  

  		

  [How does

  the stakeholder define success? 



  How is the

  stakeholder rewarded?]



  

 



 

  		

  Involvement



  

  		

  [How the

  stakeholder is involved in the project? Relate where possible to Rational

  Unified Process roles—that is, Requirements Reviewer, and so on.]



  

 



 

  		

  Deliverables



  

  		

  [Are there

  any additional deliverables required by the stakeholder?  These could be

  project deliverables or outputs from the system under development.]



  

 



 

  		

  Comments

  / Issues



  

  		

  [Problems

  that interfere with success and any other relevant information go here.]



  

 









 





3.6              

[bookmark: 3.6_______________User_Profiles]User Profiles  





[Describe

each unique user of the system here by filling in the following table for each

user type.  Remember user types can be as divergent as gurus and novices.

For example, a guru might need a sophisticated, flexible tool with

cross-platform support, while a novice might need a tool that is easy to use

and user-friendly. A thorough profile should cover the following topics for

each type of user:]





3.6.1          [bookmark: 3.6.1__________<User_Name>]<User Name>







 

  		

  Representative



  

  		

  [Who is

  the user representative to the project?  (optional  if documented

  elsewhere.)  This often refers to the Stakeholder that represents the

  set of users, for example, Stakeholder: Stakeholder1.]



  

 



 

  		

  Description



  

  		

  [A brief

  description of the user type.]



  

 



 

  		

  Type



  

  		

  [Qualify

  the user’s expertise, technical background, and degree of sophistication—that

  is, guru, casual user, etc.] 



  

 



 

  		

  Responsibilities



  

  		

  [List the

  user’s key responsibilities with regards to the system being developed— that

  is, captures details, produces reports, coordinates work, etc.]



  

 



 

  		

  Success

  Criteria



  

  		

  [How does

  the user define success?



   How

  is the user rewarded?]



  

 



 

  		

  Involvement



  

  		

  [How the

  user is involved in the project? Relate where possible to Rational Unified

  Process roles—that is, Requirements Reviewer, and the like.]



  

 



 

  		

  Deliverables



  

  		

  [Are there

  any deliverables the user produces and, if so, for whom?]



  

 



 

  		

  Comments

  / Issues



  

  		

  [Problems

  that interfere with success and any other relevant information go here.



  These

  would include trends that make the user’s job easier or harder.]



  

 









 





3.7              

[bookmark: 3.7_______________Key_Stakeholder_/_User]Key Stakeholder / User Needs





[List the

key problems with existing solutions as perceived by the stakeholder. Clarify

the following issues for each problem:





•         

What are the reasons for this problem? 





•         

How is it solved now?





•         

What solutions does the stakeholder want?]





[It is

important to understand the relative importance the stakeholder or user

places on solving each problem. Ranking and cumulative voting techniques

indicate problems that must be solved versus issues they would like

addressed.





Fill in the

following table - if using ReqPro to capture the Needs, this could be an

extract or report from that tool.]







 

  		

  Need



  

  		

  Priority



  

  		

  Concerns



  

  		

  Current Solution



  

  		

  Proposed Solutions



  

 



 

  		

  Broadcast messages



  

  		

   



  

  		

   



  

  		

   



  

  		

   



  

 



 

  		

   



  

  		

   



  

  		

   



  

  		

   



  

  		

   



  

  		

   



  

 









 





3.8              

[bookmark: 3.8_______________Alternatives_and_Compe]Alternatives and Competition





[Identify

alternatives the stakeholder perceives as available. These can include buying a

competitor’s product, building a homegrown solution or simply maintaining the

status quo. List any known competitive choices that exist, or may become

available. Include the major strengths and weaknesses of each competitor as

perceived by the stakeholder.]





3.8.1          [bookmark: 3.8.1__________<aCompetitor>]<aCompetitor>





3.8.2          [bookmark: 3.8.2__________<anotherCompetitor>]<anotherCompetitor>












4.                 

[bookmark: 4.__________________Product_Overview]Product Overview





[This

section provides a high level view of the product capabilities, interfaces to

other applications, and systems configurations. This section usually consists

of three subsections, as follows: 





•         

Product perspective 





•         

Product functions 





•           

Assumptions and dependencies]





4.1              

[bookmark: 4.1_______________Product_Perspective]Product Perspective





[This

subsection of the Vision document should put the product in perspective

to other related products and the user’s environment. If the product is

independent and totally self-contained, state it here. If the product is a

component of a larger system, then this subsection should relate how these

systems interact and should identify the relevant interfaces between the

systems. One easy way to display the major components of the larger system,

interconnections, and external interfaces is via a block diagram.]





4.2              

[bookmark: 4.2_______________Summary_of_Capabilitie]Summary of Capabilities





[Summarize

the major benefits and features the product will provide. For example, a Vision

document for a customer support system may use this part to address problem

documentation, routing, and status reporting without mentioning the amount of detail

each of these functions requires.





Organize the

functions so the list is understandable to the customer or to anyone else

reading the document for the first time. A simple table listing the key

benefits and their supporting features might suffice. For example:]





Customer Support System







 

  		

  Customer Benefit



  

  		

  Supporting Features



  

 



 

  		

  New support staff can quickly get

  up to speed.



  

  		

  Knowledge base assists support

  personnel in quickly identifying known fixes and workarounds



  

 



 

  		

  Customer satisfaction is improved

  because nothing falls through the cracks.



  

  		

  Problems are uniquely itemized,

  classified and tracked throughout the resolution process. Automatic

  notification occurs for any aging issues.



  

 



 

  		

  Management can identify problem areas

  and gauge staff workload.



  

  		

  Trend and distribution reports

  allow high level review of problem status.



  

 



 

  		

  Distributed support teams can

  work together to solve problems.



  

  		

  Replication server allows current

  database information to be shared across the enterprise



  

 



 

  		

  Customers can help themselves,

  lowering support costs and improving response time.



  

  		

  Knowledge base can be made

  available over the Internet. Includes hypertext search capabilities and

  graphical query engine



  

 









4.3              

[bookmark: 4.3_______________Assumptions_and_Depend]Assumptions and Dependencies





[List each

of the factors that affects the features stated in the Vision document.

List assumptions that, if changed, will alter the Vision document. For

example, an assumption may state that a specific operating system will be

available for the hardware designated for the software product. If the

operating system is not available, the Vision document will need to

change.]





4.4              

[bookmark: 4.4_______________Cost_and_Pricing]Cost and Pricing





[For

products sold to external customers and for many in- house applications, cost

and pricing issues can directly impact the applications definition and

implementation. In this section, record any cost and pricing constraints that

are relevant. For example, distribution costs, (# of diskettes, # CD-ROMs, CD

mastering) or other cost of goods sold constraints (manuals, packaging) may be

material to the projects success, or irrelevant, depending on the nature of the

application.]





4.5              

[bookmark: 4.5_______________Licensing_and_Installa]Licensing and Installation





[Licensing

and installation issues can also directly impact the development effort. For

example, the need to support serializing, password security or network

licensing will create additional requirements of the system that must be

considered in the development effort.





Installation

requirements may also affect coding, or create the need for separate

installation software.]












5.                 

[bookmark: 5.__________________Product_Features]Product Features





[List and

briefly describe the product features. Features are the high-level capabilities

of the system that are necessary to deliver benefits to the users. Each feature

is an externally desired service that typically requires a series of inputs to

achieve the desired result. For example, a feature of a problem tracking system

might be the ability to provide trending reports. As the use-case model takes

shape, update the description to refer to the use cases.





Because the Vision

document is reviewed by a wide variety of involved personnel, the level of

detail should be general enough for everyone to understand. However, enough

detail should be available to provide the team with the information they need

to create a use-case model.





To

effectively manage application complexity, we recommend for any new system, or

an increment to an existing system, capabilities are abstracted to a high

enough level so 25-99 features result. These features provide the fundamental

basis for product definition, scope management, and project management. Each

feature will be expanded in greater detail in the use-case model.





Throughout

this section, each feature should be externally perceivable by users, operators

or other external systems. These features should include a description of

functionality and any relevant usability issues that must be addressed. The

following guidelines apply:





•         

Avoid design. Keep feature descriptions at a general level. Focus on

capabilities needed and why, (not how)  they should be implemented.





•         

If you are using the Requisite toolkit, all should be selected as requirements

of type for easy reference and tracking.]





5.1              

[bookmark: 5.1_______________<aFeature>]<aFeature>





 





5.2              

[bookmark: 5.2_______________<anotherFeature>]<anotherFeature>





 












6.                 

[bookmark: 6.__________________Constraints]Constraints 





[Note any

design constraints, external constraints or other dependencies.]





7.                 

[bookmark: 7.__________________Quality_Ranges]Quality Ranges 





[Define the

quality ranges for performance, robustness, fault tolerance, usability, and

similar characteristics that are not captured in the Feature Set.]





8.                 

[bookmark: 8.__________________Precedence_and_Prior]Precedence and Priority





[Define the

priority of the different system features.]





9.                 

[bookmark: 9.__________________Other_Product_Requir]Other Product Requirements





[At a

high-level, list applicable standards, hardware or platform requirements,

performance requirements, and environmental requirements.]





9.1              

[bookmark: 9.1_______________Applicable_Standards]Applicable Standards





[List all

standards with which the product must comply. These can include legal and

regulatory (FDA, UCC) communications standards (TCP/IP, ISDN), platform

compliance standards (Windows, Unix, etc.), and quality and safety standards

(UL, ISO, CMM).]





9.2              

[bookmark: 9.2_______________System_Requirements]System Requirements





[Define any

system requirements necessary to support the application. These can include the

supported host operating systems and network platforms, configurations, memory,

peripherals, and companion software.]





9.3              

[bookmark: 9.3_______________Performance_Requiremen]Performance Requirements





[Use this

section to detail performance requirements. Performance issues can include such

items as user load factors, bandwidth or communication capacity, throughput,

accuracy, and reliability or response times under a variety of loading

conditions.]





9.4              

[bookmark: 9.4_______________Environmental_Requirem]Environmental Requirements





[Detail

environmental requirements as needed. For hardware- based systems,

environmental issues can include temperature, shock, humidity, radiation, etc.

For software applications, environmental factors can include usage conditions,

user environment, resource availability, maintenance issues, and error

handling, and recovery.]





10.            

[bookmark: 10._____________Documentation_Requiremen]Documentation Requirements





[This

section describes the documentation that must be developed to support successful

application deployment.]





10.1            [bookmark: 10.1____________User_Manual]User Manual





[Describe

the purpose and contents of the User Manual. Discuss desired length, level of

detail, need for index, glossary of terms, tutorial vs. reference manual

strategy, etc. Formatting and printing constraints should also be identified.]





10.2            [bookmark: 10.2____________On-line_Help]On-line Help





[Many

applications provide an on-line help system to assist the user. The nature of

these systems is unique to application development as they combine aspects of

programming (hyperlinks, etc) with aspects of technical writing (organization,

presentation). Many have found the development of on-line help system is a

project within a project that benefits from up-front scope management and

planning activity.]





10.3            [bookmark: 10.3____________Installation_Guides,_Con]Installation Guides, Configuration, Read Me

File





[A document

that includes installation instructions and configuration guidelines is

important to a full solution offering. Also, a Read Me file is typically

included as a standard component. The Read Me can include a "What's New

With This Release” section, and a discussion of compatibility issues with

earlier releases. Most users also appreciate documentation defining any known

bugs and workarounds in the Read Me file.]





10.4            [bookmark: 10.4____________Labeling_and_Packaging]Labeling and Packaging





[Today's state

of the art applications provide a consistent look and feel that begins with

product packaging and manifests through installation menus, splash screens,

help systems, GUI dialogs, etc. This section defines the needs and types of

labeling to be incorporated into the code. Examples include copyright and

patent notices, corporate logos, standardized icons and other graphic elements,

etc.]





11.            

[bookmark: 11._____________Appendix_1_-_Feature_Att]Appendix 1 - Feature Attributes





[Features

should be given attributes that can be used to evaluate, track, prioritize, and

manage the product items proposed for implementation. All requirement types and

attributes should be outlined in the Requirements Management Plan, however you

may wish to list and briefly describes the attributes for features that have been

chosen. Following subsections represent a set of suggested feature attributes.]





11.1            [bookmark: 11.1____________Status]Status





[Set after

negotiation and review by the project management team. Tracks progress during

definition of the project baseline.]







 

  		

  Proposed



  

  		

  [Used to

  describe features that are under discussion but have not yet been reviewed

  and accepted by the "official channel," such as a working group

  consisting of representatives from the project team, product management and

  user or customer community.]



  

 



 

  		

  Approved



  

  		

  [Capabilities

  that are deemed useful and feasible and have been approved for implementation

  by the official channel. ]



  

 



 

  		

  Incorporated



  

  		

  [Features

  incorporated into the product baseline at a specific point in time.]



  

 









11.2            [bookmark: 11.2____________Benefit]Benefit





[Set by

Marketing, the product manager or the business analyst. All requirements are

not created equal. Ranking requirements by their relative benefit to the end

user opens a dialogue with customers, analysts and members of the development

team. Used in managing scope and determining development priority.]







 

  		

  Critical



  

  		

  [Essential

  features. Failure to implement means the system will not meet customer needs.

  All critical features must be implemented in the release or the schedule will

  slip.]



  

 



 

  		

  Important



  

  		

  [Features

  important to the effectiveness and efficiency of the system for most

  applications. The functionality cannot be easily provided in some other way.

  Lack of inclusion of an important feature may affect customer or user

  satisfaction, or even revenue, but release will not be delayed due to lack of

  any important feature.]



  

 



 

  		

  Useful



  

  		

  [Features

  that are useful in less typical applications, will be used less frequently,

  or for which reasonably efficient workarounds can be achieved. No significant

  revenue or customer satisfaction impact can be expected if such an item is

  not included in a release.]



  

 









 





11.3            [bookmark: 11.3____________Effort]Effort





[Set by the

development team. Because some features require more time and resources than

others, estimating the number of team or person-weeks, lines of code required

or function points, for example, is the best way to gauge complexity and set

expectations of what can and cannot be accomplished in a given time frame. Used

in managing scope and determining development priority.]





11.4            [bookmark: 11.4____________Risk]Risk





[Set by

development team based on the probability the project will experience

undesirable events, such as cost overruns, schedule delays or even

cancellation. Most project managers find categorizing risks as high, medium,

and low sufficient, although finer gradations are possible. Risk can often be

assessed indirectly by measuring the uncertainty (range) of the projects teams

schedule estimate.]





11.5            [bookmark: 11.5____________Stability]Stability





[Set by

analyst and development team based on the probability the feature will change

or the team’s understanding of the feature will change. Used to help establish

development priorities and determine those items for which additional

elicitation is the appropriate next action.]





11.6            [bookmark: 11.6____________Target_Release]Target Release





[Records the

intended product version in which the feature will first appear. This field can

be used to allocate features from a Vision document into a particular

baseline release. When combined with the status field, your team can propose,

record and discuss various features of the release without committing them to

development. Only features whose Status is set to Incorporated and whose Target

Release is defined will be implemented. When scope management occurs, the

Target Release Version Number can be increased so the item will remain in the Vision

document but will be scheduled for a later release.]





11.7            [bookmark: 11.7____________Assigned_To]Assigned To





[In many

projects, features will be assigned to "feature teams" responsible for

further elicitation, writing the software requirements and implementation. This

simple pull down list will help everyone on the project team better understand

responsibilities.]





11.8            [bookmark: 11.8____________Reason]Reason





[This text

field is used to track the source of the requested feature. Requirements exist

for specific reasons. This field records an explanation or a reference to an

explanation. For example, the reference might be to a page and line number of a

product requirement specification, or to a minute marker on a video of an

important customer interview.]





 











